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Author Questionnaire
1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  No

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Yes
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
As these files are necessary for finalizing your script, please upload all screen-captured video files to your project page as soon as possible: https://review.jove.com/account/file-uploader?src=20400278


3. Filming location: Will the filming need to take place in multiple locations?   No.

Current Protocol Length
Number of Steps:  23
Number of Shots:  47

Introduction

Videographer: Obtain headshots for all authors available at the filming location. 
AUTHORS: Please note that the all interview statements are now restricted to 30 words, as per the new update. The statements have been edited for brevity. Only 5 statements may be presented. 

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Ewa Niechwiej-Szwedo: Our research develops objective psychophysiological measures of pilots' situation awareness using eye tracking to enhance data-driven, competency-based training and assessment.
1.1.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, looking slightly off-camera. 

What are the most recent developments in your field of research?
1.2. Naila Ayala: Advancements in eye tracking enhance aviation training by monitoring attentional states like fatigue, cognitive load, and mind wandering, improving pilot performance and safety.
1.2.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, looking slightly off-camera. What technologies are currently used to advance research in your field?
1.3. Naila Ayala: Integrated eye tracking in simulators, VR, and AR enables realistic assessments of pilot mental state and scanning behaviors, advancing research beyond labs into actual cockpits and high-fidelity simulations.
1.3.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B.roll:2.4
What are the current experimental challenges?
1.4. Naila Ayala: A key challenge is area of interest segmentation and label validation, which are labor-intensive but crucial. Our experiment explores an early-stage automation method requiring further development.
1.4.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B.roll:2.10

What significant findings have you established in your field?
1.5. Naila Ayala: My work supports eye tracking in aviation training to assess pilots' information processing, attention allocation, stress management, and gaze behaviors that indicate risks affecting aircraft monitoring and safety.
1.5.1. INTERVIEW: Named Talent says the statement above in an interview-style shot, looking slightly off-camera. Suggested B.roll:3.3

Videographer: Obtain headshots for all authors available at the filming location.


Testimonial Questions:

How does the research community benefit from video publications as compared to standard text publications?
1.1. Naila Ayala: The benefit of a video publication is mainly that setup procedures are able to be demonstrated and followed much more effectively than using many pictures and text alone.



Ethics Title Card
This research has been approved by the Office of Research Ethics at the University of Waterloo 


Protocol 

2. Hardware Setup and Calibration Protocol for Eye Tracking in Flight Simulators
Demonstrator: Naila Ayala
Protocol
2.1. To begin, turn the flight simulator and projector screens on [1]. On the instruction screen, press the Presets tab [2] and verify that the required position and/or weather presets are available [3-TXT]. 
2.1.1. WIDE: Talent turning on the simulator and projector screens.   Videographer: In addition to this video shot, please also take a photograph of talent performing this action. Make sure that it is at least a half-body shot with the talent's face visible and zoom out so we have room for cropping. 
2.1.2. Talent presses the Presets tab.  
2.1.3. List of position and weather presets being checked for availability.  TXT: If needed, create a new preset type 

2.2. Next, turn the collection laptop and wearable eye tracker on [1] and log in using the credentials [2]. When prompted, either select a preexisting profile, create a new one for a new participant, or select the Guest option to overwrite its last calibration [3]. Then, select the nosepiece [4].  
2.2.1. WIDE: Talent turning on the laptop and wearable eye tracker .
2.2.2. SCREEN: Talent entering the logging details.  This shot was done by the videographer. No close up of login details were done as to comply with ethics security guidelines.
Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible: https://review.jove.com/account/file-uploader?src=20400278
2.2.3. SCREEN: Prompt for profile selection or creation displayed on the laptop.  
2.2.4. Talent selecting the nosepiece from the device.  

2.3. To calibrate the glasses, open the eye tracker case and take out the glasses [1]. Connect the USB (U-S-B) to the micro-USB cable from the laptop to the glasses [2-TXT].  These steps were done in take 2.2.1.
2.3.1. WIDE: Talent opening the eye tracker case and removing the glasses.  
2.3.2. Talent connecting the USB to micro-USB cable between the laptop and glasses. TXT: Update the firmware, if required

2.4. Then, locate the black calibration box inside the eye tracker case [1]. On the collection laptop, in the Eye Tracking Hub, choose Tools and then Device Calibration [2]. Place the glasses inside the calibration box [3] and press Start on the popup window to begin calibration [4]. Once calibration is complete, remove the glasses from the box [4].  
2.4.1. Talent locating the black calibration box inside the eye tracker case.  
2.4.2. SCREEN: Eye Tracking Hub showing the Tools > Device Calibration option being selected.  
2.4.3. Talent placing the glasses inside the black calibration box.  
2.4.4. SCREEN: The start is being pressed
2.4.5. Talent removing the glasses from the box after calibration is complete.  

2.5. To ensure a proper nosepiece fit, instruct the participant to sit in the cockpit and put on the glasses [1]. In the Eye Tracking Hub, navigate to File, Settings, and Nose Wizardthe bottom right corner and click on “glasses fit” [2].  
2.5.1. WIDE: Participant sitting in the cockpit and putting on the glasses.  
2.5.2. SCREEN: Eye Tracking Hub showing “glasses fit”File > Settings > Nose Wizard being selected. This step was deleted as step 2.6 repeats it and goes into more detail about it below.

2.6. Check the Adjust Fit of Your Glasses box on the left bottom right side of the screen. If the fit is marked as Excellent, proceed to the next step. Otherwise, click the box [1].  
2.6.1. SCREEN: The Adjust Fit of Your Glasses box is displayed on the left bottom right side of the screen, and the fit status is shown.  

2.7. Then, instruct the participant to follow the on-screen fit recommendations, adjust the nosepiece, ensure the glasses fit comfortably, and look straight ahead at the laptop [1].
2.7.1. Participant adjusting the glasses and nosepiece as per onscreen recommendations.  

2.8. Now, pinch the nosepiece in the middle, slide it out from the glasses [1], and slide another one in [2-TXT].  
2.8.1. Talent pinching the nosepiece in its middle and sliding it out.  
2.8.2. Talent inserting a new nosepiece into the glasses.  TXT: Continue testing different nosepieces until the best fit is identified 

2.9. Then, check that the headset is hooked up to the jack on the left underside of the instrument panel [1].  
2.9.1. WIDE: Talent ensuring the headset is properly connected to the jack under the instrument panel.

2.10. For eyeballPrior to eyeball calibration, navigate to the parameter box in the Eye Tracking Hub [1]. Check the calibration mode and select either Fixed Gaze or Fixed Head as appropriate for the study [2]. Ensure the calibration points are displayed as a 35 x 35 grid (FiveThree-by-FiveThree-Grid), totaling 25 9 points [3]. Verify that the validation mode matches the calibration mode [4]. Then, examine the eye-tracking outputs and ensure all required parameters for the study are checked using the tick boxes [5]. This must be done before actual calibration this is automatically completed after selecting a nose piece. Accordingly, this step and all sub-2.10 steps should be done before step 2.5. 
2.10.1. SCREEN: Eye Tracking Hub with the parameter box highlighted.  
2.10.2. SCREEN: Calibration mode being selected as Fixed Gaze or Fixed Head.  
2.10.3. SCREEN: Calibration grid displaying 25 9 points (35 x 35).  
2.10.4. SCREEN: Validation mode settings matching the calibration mode.  
2.10.5. SCREEN: Tick boxes are being checked for all necessary eye-tracking outputs.  

2.11. In the Eye Tracking Hub, click File, Settings, and AdvancedEye Tracking. Check that the sampling rate is set to 250 Hertz [1].  
2.11.1. SCREEN: Eye Tracking Hub displaying File > Settings > Advanced Eye Tracking being accessed.  Advanced settings showing the sampling rate as 250 Hertz.  

2.12. Then, check the Calibrate Your Eye Tracking box on the screen using the mouse calibration will begin automatically once nose piece is selected [1]. To follow the fixed gaze calibration mode for the study, instruct the participant to move their head so that the box overlaps with the black square and aligns [2]. Then, ask the participant to focus their gaze on the crosshair inside the black square and press the space bar [3].  
2.12.1. SCREEN: Calibrate Your Eye Tracking box being selected.  This was deleted because no calibration box is selected in the new software update. It automatically starts once the nose wizard ends after section 2.8.2. As such these shots under section 2.12 (calibration- includes 2.12.2 and 2.12.3) should be moved after 2.8.2 (insert nose piece)
2.12.2. Participant adjusting their head so the box aligns with the black square.  
2.12.3. Participant focusing on the crosshair and pressing the space bar.

2.13. Press the Validate Your Setup box and check that the Mean Absolute Error is less than 1 degree [1]. 
2.13.1. SCREEN: Validate Your Setup box being selected on the screen. Validation results showing the MAE.  

2.14. After completing calibration and validation, press Save Calibration to save the calibration to the profile [1].  
2.14.1. SCREEN: Save Calibration button being pressed to store the calibration to the participant’s profile.  This was deleted because the new software automatically saves the latest calibration after validation is completed.

2.15. For  data collection, give the participant clear instructions about the trial or flight path, including how to adjust the settings on the instrument panel, before the simulation starts [1].
2.15.1. WIDE: Talent giving instructions to the participant about the trial and flight path.  

2.16. On the instruction screen, press the orange STOPPED button to start data collection [1-TXT]. Confirm that the color changes to green and the text updates to FLYING [2]. 
2.16.1. Instruction screen showing the orange STOPPED button being pressed.  TXT: Ensure to give a verbal cue to the participant as the STOPPED button is pressed
2.16.2. The button turns green and displays FLYING.   

2.17. On the collection laptop, press Start Recording to synchronize the eye tracker data with the flight simulator data [1].  
2.17.1. SCREEN: Start Recording button being pressed in the collection software.  


2.18. When the participant has completed their circuit and landed, wait until the aircraft has come to a complete stop [1].  
2.18.1. WIDE: Participant finishing the circuit and aircraft coming to a complete stop.


2.19. On the instruction screen, press the green FLYING button to stop data collection [1]. Confirm that the color changes back to orange and the text updates to STOPPED [2-TXT].   
2.19.1. Instruction screen showing the green FLYING button being pressed.  
2.19.2. Button turning orange and displaying STOPPED.  TXT: Give a verbal cue to the participant 

2.20. Run an eye-tracking batch script to manually define Areas of interest or AOIs (A-O-Eyes) for gaze mapping. The script will open a new window for keyframe selection [1]. Scroll through the video and choose a frame that clearly shows all the key AOIs to be analyzed [2].  
2.20.1. SCREEN: Batch script being executed and a new window for key frame selection opening.  
2.20.2. SCREEN: User scrolling through the video to find a frame that displays all key AOIs.  

2.21. Follow the onscreen instructions to draw a rectangle over a region of the frame that is visible throughout the entire video, unique, and remains stable [1].  
2.21.1. SCREEN: Onscreen instructions guide the user to draw a rectangle over a stable region in the frame.  

2.22. Then, draw a rectangle for each AOI in the frame, one at a time [1]. Name each rectangle accordingly. Use the Add More button to add new AOIs and press Done on the last one [2]. For gaze coordinates that fall within the defined object space in the "in-screen" coordinate frame during a fixation, label the fixation with the corresponding AOI label [3].  
2.22.1. SCREEN: User drawing rectangles for each AOI in the frame.  
2.22.2. SCREEN: Naming each AOI appropriately after drawing the rectangle.   Add More button being used to add additional AOIs and Done being pressed after the final one.  
2.22.3. SCREEN: Gaze coordinates being labeled with AOI labels based on fixation location.

2.23. Start the script to process the AOIs and generate fixation data, which will generate a plot showing the saccades and fixations over the video [1].  
2.23.1. SCREEN: Script being initiated to process AOIs and generate fixation data.  Plot displaying saccades and fixations mapped over the video.



Results
3. Representative Results
3.1. Emergency task conditions significantly reduced the success rate of landings compared to basic conditions [1]. Completion time was significantly shorter in emergency trials compared to basic trials [2]. Landing error was also significantly higher in emergency trials compared to basic trials [3]. 
3.1.1. LAB MEDIA: Figure 7A. Video Editor: please emphasize the marks corresponding to “Emergency”
3.1.2. LAB MEDIA: Figure 7B. Video Editor: please emphasize the marks corresponding to “Emergency”
3.1.3. LAB MEDIA: Figure 7C. Video Editor: please emphasize the marks corresponding to “Emergency”
3.2. The subjective situation awareness score was significantly lower during emergency tasks compared to basic tasks [1]. The situation awareness supply and demand increased from the basic to the emergency trials [2] and situation awareness understanding decreased from the basic to the emergency trials [3]. 
3.2.1. LAB MEDIA: Figure 8A. Video Editor: please emphasize the marks corresponding to “Emergency”
3.2.2. LAB MEDIA: Figure 8B-C. Video Editor: please emphasize the marks corresponding to “Emergency”
3.2.3. LAB MEDIA: Figure 8D. Video Editor: please emphasize the marks corresponding to “Emergency”

3.3. Gaze metrics revealed significant reductions in dwell time on key instruments like the altimeter and attitude indicators under emergency conditions [2].
3.3.1. LAB MEDIA: Figure 9. Video Editor: please emphasize the inverted columns 
3.4. Blink rate increased significantly under emergency conditions compared to basic conditions [1]. Advanced gaze metrics like SGE (S-G-E) and GTE (G-T-E) were significantly reduced under emergency conditions [2]. 
3.4.1. LAB MEDIA: Figure 10. Video Editor: please emphasize the marks corresponding to “Emergency”
3.4.2. LAB MEDIA: Figure 11A and 11B. Video Editor: please emphasize the marks corresponding to “Emergency” of both graphs
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